StarFire User Manual

Table of Contents

Table of Figures ................................................................. 4
Technical Support ................................................................ 5
Updates to Firmware and Adding Communication Channels .......... 5
Limited Warranty: .................................................................. 6
SAFETY WARNING: ............................................................. 6
Introduction and History ......................................................... 7
  About ACE Pyro ............................................................... 7
  Why StarFire? .................................................................. 7
  Main Design Considerations ............................................... 7
Components of the StarFire System ........................................... 8
  Included Components ....................................................... 8
  Additional Items Required ............................................... 8
  Items Only Required for a Scripted Display ......................... 8
Charging the Batteries ............................................................ 9
  Battery Maintenance ....................................................... 9
  Charging Procedure ...................................................... 9
  On-Screen Battery Indicator .............................................. 9
Getting Familiar with the StarFire Controller ............................ 10
Getting Familiar with the StarFire Module ............................... 11
Getting Familiar with the Dead Man/StepFire Grip .................... 12
StarFire PC Software and Driver Installation ............................ 13
  Overview ....................................................................... 13
  Connecting the StarFire Controller to your PC ..................... 13
  Steps: .......................................................................... 13
Windows 7 Install .................................................................. 14
  Installing the Prolific Driver for StarFire on Windows 7 .......... 14
  Verify the Prolific Driver was Successfully Installed on Windows 7 ........................................................................ 17
Windows XP Install ............................................................... 18
  Installing the Prolific Driver for StarFire on Windows XP ........ 18
  Verify the Prolific Driver was Successfully Installed on Windows XP ........................................................................ 21
Installing the StarFire Software ............................................. 22
  Window 7 or Window XP.................................................. 22
Testing Communication between the StarFire Software on your PC and the Controller ...................................................... 25
How to Connect the Module(s) to the Controller and Scan for Modules ............................................................. 26
How to Program the Module Address Numbers and
Read the Module Address (from the controller) .............................. 28
  Read the Module Address (directly from module) ................... 29
Basic Show Setup .................................................................. 30
  Checklist ..................................................................... 30
Diagnose .......................................................... 65
System Version .................................................................................. 65
Run LED Test ...................................................................................... 66
Continuous Scanning ........................................................................... 66
Updating the StarFire Controller ......................................................... 67
Preparing for Updates ......................................................................... 67
Updating the StarFire Controller GUI .................................................. 68
Updating the I/O Card Firmware ......................................................... 69
Updating the Communications Board Firmware ................................... 70
Updating the Field Module Firmware .................................................. 71
Test Mode in StarFire Software on PC .................................................. 73
Description of Controller Components and Connections ..................... 74
1. Communication Channel Terminals ................................................. 74
2. Power Plug ...................................................................................... 74
3. Light Connection ............................................................................. 74
4. Time Code Inputs ........................................................................... 74
5. Network Connection .................................................................... 74
6. Computer USB-B Input ................................................................ 74
7. USB-A for Flash Drive .................................................................. 74
8. Display Softkeys ............................................................................ 74
9. Color Display Monitor with Interactive Menu ................................. 74
10. Master Power Switch .................................................................... 75
11. Safe/Arm Key Switch & LED ......................................................... 75
12. Dead Man/StepFire Grip Connector .............................................. 75
13. Emergency Shut Off Switch ......................................................... 75
14. Cue Firing Softkeys & LEDs ........................................................ 75
15. Module Selector Keypad ............................................................... 75
Cleaning and Caring For Your StarFire ................................................ 76
Protecting the Equipment ..................................................................... 76
Controller and Screen .......................................................................... 76
Module(s) ............................................................................................ 76
Rail(s) ................................................................................................. 76
Cables & Duplex Data Wire ................................................................. 76
Module Wiring Limitation Chart .......................................................... 77
Table of Figures

Figure 1: Battery Indicator ................................................................. 9
Figure 2: Controller Layout ............................................................. 10
Figure 3: Module Layout ................................................................. 11
Figure 4: Dead Man/StepFire Grip .................................................... 12
Figure 5: Connecting the Controller to your PC ............................... 13
Figure 6: Modules not scanned. ....................................................... 26
Figure 7: Scanning for Modules ....................................................... 27
Figure 8: Assign Module Addresses ............................................... 28
Figure 9: Read the Module Address (directly from module) ............... 29
Figure 10: Basic Field Setup ........................................................... 31
Figure 11: Check Module Status ..................................................... 33
Figure 12: System Armed ............................................................... 34
Figure 13: Module Status ............................................................... 35
Figure 14: Module Continuity ......................................................... 37
Figure 15: Manual Firing Mode ....................................................... 39
Figure 16: Manual Firing "Cue" Softkeys ......................................... 40
Figure 17: StepFire in Manual Firing Mode ...................................... 41
Figure 18: Software - "Connected" or "Not Connected" to the controller ... 42
Figure 19: Software - File, Tools and Help menus .......................... 42
Figure 20: Software - Find Updates ............................................... 42
Figure 21: Software - Window Tabs ............................................... 42
Figure 22: Software - Script Tab ..................................................... 43
Figure 23: Software - System Testing Tab ...................................... 43
Figure 24: Software - Fire Control Tab .......................................... 43
Figure 25: Sorting Data in Software Tables ..................................... 44
Figure 26: Excel Template for a Basic Script .................................. 46
Figure 27: Opening a Script into the Software .................................. 47
Figure 28: Scripted Show - Continuity Check Through the Software .... 51
Figure 29: Transferring/Downloading the Script to Controller .......... 52
Figure 30: Sending the Script to the Modules .................................. 54
Figure 31: Sequence Fire Script View ............................................ 60
Technical Support
If after following the procedures in this manual and you still need technical support, please contact:

ACE Pyro, LLC
877-223-3552
734-428-0900
info@starfiresales.com

Updates to Firmware and Adding Communication Channels

Upgrading your StarFire system to Version 2:

Version 1 StarFire controllers and modules must be returned to ACE Pyro for upgrade to Version 2. The update is free of charge and includes enhanced communication channel hardware, a new graphical user interface, and firmware updates for the field modules and controller.

Each StarFire controller supports 8 communication channels. Additional communication channels can be added after initial purchase but upgrade must be installed by ACE Pyro. If you own a Version 2 StarFire system software and firmware updates for can be installed remotely. Please refer to page 67, “Updating the StarFire Controller.”
Limited Warranty:
ACE Pyro, LLC warrants each new StarFire system to be free from defects in material and workmanship. This warranty is applicable only for 12 months from the date of delivery to the original purchaser. Under no circumstances will it cover any merchandise or components thereof, which, in the opinion of the company, has been subject to misuse, unauthorized modification, alteration, an accident or if repairs have been made with parts other than those obtainable through ACE Pyro, LLC. Software and firmware updates are not considered a warranty repair, unless, in the opinion of the company the hardware is not functional without a software update. Our obligation under this warranty shall be limited to repairing or replacing, free of charge to the original purchaser, any part that, in our judgment, shall show evidence of such defect, provided further that such part, if so requested shall be returned within forty-five (45) days from date of failure to ACE Pyro, LLC. Shipping from the customer to ACE Pyro, LLC shall be the responsibility of the purchaser. ACE Pyro, LLC will pay for return ground shipping to the customer. This warranty shall not interpret to render ACE Pyro, LLC liable for injury or damages of any kind or nature to person or property. This warranty does not extend to loss due to equipment failure, system malfunction or any expense or loss incurred for labor, substitute machinery, rental or for any other reason. Except as set forth above, ACE Pyro, LLC shall have no obligation or liability of any kind on account of any of its equipment and shall not be liable for special or consequential damages. ACE Pyro, LLC makes no other warranty, expressed or implied, and specifically, ACE Pyro, LLC disclaims any implied warranty or merchantability or fitness for a particular purpose. Some States or provinces do not permit limitations or exclusion of implied warranties or incidental or consequential damages, so the limitations or exclusion in this warranty may not apply. This warranty is subject to any existing conditions of supply which may directly affect our ability to obtain materials or manufacture replacement parts. ACE Pyro, LLC reserves the right to make improvements in design or changes in specifications at any time, without incurring any obligation to owners of units previously sold. ACE Pyro, LLC reserves the right to update or alter, modify or enlarge this warranty and the exclusions, limitations and reservations.

SAFETY WARNING:
The StarFire Controller should always be turned “OFF” whenever the duplex wires are being connected, removed or reconnected to the modules or the comms channel terminals. As with any electrical system great care should be taken to not allow the wires to touch each other. Accidental shorting out of the comms channel may occur if wires touch. If this occurs, the red LED light for the comms channel (between the terminals) on the controller will blink. Great care should be taken to insure that nothing conductive is placed on the controller near any of the terminals or any other input connections.
Introduction and History

About ACE Pyro
Aaron Enzer began shooting fireworks commercially since 1996. ACE Pyro was founded in 1998. In 1999 Aaron purchased his first digital computer firing system. Today ACE Pyro continues to expand its product lines and support the growth of its wholesale and display divisions. Included in this growth is the ongoing development of various products and services used by fireworks professionals and hobbyists alike.

Why StarFire?
“I have been shooting computer fired displays with a variety of different firing systems for several years. Through my membership in the PGI (Pyrotechnics Guild International), I have been able to see most of the major systems in action. I’ve talked to people that use them – about what they like and what they do not like etc.”

– Aaron Enzer

From this experience StarFire was born.

Main Design Considerations
- Safety
- Ease of use
- Robust operation
- Economical
- Manual electric firing
- Sequence firing
- Accurately and precisely timed fully automatic digital firing
Components of the StarFire System

Included Components

1. StarFire controller
2. Battery charger (future generations will use an IEC C13 Power Cord)
3. USB A to B cable
4. StarFire module(s)
5. Centronics cable(s)
6. Rail(s)
7. Arm keys
8. StarFire XLR dead man/step fire grip
9. External light

Additional Items Required

1. Duplex wire (22AWG or larger) (not included)

Items Only Required for a Scripted Display

1. Windows based computer/laptop or USB Thumb Drive
2. USB A to B cable
3. StarFire PC software (included on internal USB Disk)
4. XLR or RCA audio cable
Charging the Batteries

The StarFire Controller contains three lead acid batteries.

Battery Maintenance

For best practice batteries should be fully charged before each display. Lead acid batteries should not be fully discharged or stored for extended periods of time without being charged. To extend battery life, fully charge the controller at least once every 6 months when in extended storage.

Charging Procedure

1. Plug the battery charger into an AC outlet and connect to the StarFire controller as shown at right.

Note: charging status is indicated by a light on the charger. Orange indicates charging in progress. Green indicates fully charged. The on screen battery indicator may not change during the charging process.

On-Screen Battery Indicator

The Battery Indicator is a blue bar in the top left corner of the screen. When fully charged the blue bar will extend to the end of the Battery Indicator on screen. As available power is reduced the blue bar will also reduce.

Above the Battery Indicator is a Voltage Indicator that will read out the current battery voltage. A voltage at or above 36 Volts indicates a good voltage. If voltage drops below 36 Volts, the batteries need to be charged.

The controller may be used while it is plugged into the battery charger.

Note: Do not attempt to open the StarFire controller to access the batteries. If for any reason the batteries need to be replaced, the controller should be returned.
Getting Familiar with the StarFire Controller

Figure 2: Controller Layout

1. Comm Channel Terminals with red/green LED
2. Power Plug (IEC C14)
3. Light Connection (Light not included)
4. Time Code input
5. Network Connection
6. Computer USB-B Input
7. USB-A for Flash Drive

8. Display Softkeys
9. Color Display Monitor
10. Master Power Switch
11. Safe/Arm Key Switch & LED
12. Dead Man/StepFire Grip Connector
13. Emergency Shut off Switch
14. Cue Firing Softkeys & LEDs
15. Module Selector Keypad

Also see: Description of Controller Components and Connections (page 74) for more detailed descriptions.
Figure 3: Module Layout
As the name indicates, the grip is used as either a “Dead Man” trigger switch during a scripted show or a “StepFire” button during a manual show.
StarFire User Manual

StarFire PC Software and Driver Installation

Overview
The StarFire PC software is used for scripted displays. While a scripted display can be conducted without the use of an external PC the software provides enhanced functionality for script editing and continuity checking that is not available directly on the StarFire controller.

The latest version of the StarFire software is available on our website http://www.starfiresales.com/update

Connecting the StarFire Controller to your PC

Connecting you PC to the StarFire controller has two functions:

a. It allows your PC to access a USB flash drive installed in the StarFire controller. The USB flash drive is only accessible from an external PC and can be used for file storage and/or backup including software, script files, audio files, etc. The USB flash drive is accessible using any PC running Windows XP or later and does not require prior installation of any software or drivers.

b. It allows your PC to communicate with the StarFire controller making it possible to transfer scripts, perform advanced continuity checking, and other diagnostics. This functionality requires the installation of software and drivers on the external PC/laptop.

Steps:
1. Connect the USB A to B cable to the “Computer Input” port on the StarFire panel as shown in Figure 5.
2. Connect the other end of the USB A to B cable to an available USB port on your PC/laptop.

Figure 5: Connecting the Controller to your PC

3. A USB disk should be recognized by your computer. If you are running Windows 7 proceed to the next instruction set. If you are running Windows XP jump to page 16 for the Windows XP installation steps.
Windows 7 Install

The StarFire uses a USB-Serial connection to communicate with your PC. Windows 7 requires an additional driver to make this possible. After connecting StarFire to your computer you may see a brief message pop-up at the bottom right side of the screen.

Installing the Prolific Driver for StarFire on Windows 7

1. Locate the driver on the STARFIRE USB disk.

   a. If an AutoPlay pop-up window appears asking what you’d like to do with the new STARFIRE (E:) that was detected…
      Click “Open folder to view files.”

   b. If AutoPlay does not launch, use Widows Explorer to navigate to the StarFire USB disk, Start > My Computer > STARFIRE (E:)

   c. Or use the keyboard shortcut “windows/start key) + E.”
      Double click the STARFIRE (E:) disk to open.
Note: The StarFire disk is listed as a removable disk. Depending on the generation of your StarFire, the disk may or may not be named “STARFIRE.” It may show up as “USB DISK (E:)” (the letter of the disk may vary also)

2. Double click “PL2303_Prolific_DriverInstaller_v1210.exe” to install the Driver.

3. You will see “Preparing Setup” then the InstallSheild Wizard will open. Click “Next”
4. You will see the install Setup Status. The install may take a few minutes. 
*Note: If the Setup Status window is automatically minimized or disappears, just wait for it to finish.*

5. On the Install Shield Wizard Complete window
   Click “Finish”
Verify the Prolific Driver was Successfully Installed on Windows 7

1. Navigate to and open the Devices and Printers window on your PC. From the Start menu select Devices and Printers. 
   *Note: If you do not see this directly in the Start Menu look in Control Panel.*

   ![Devices and Printers Window](image)

   Notice at the bottom, under Unspecified are two (2) Prolific USB-to-Serial Comm Ports now listed. The numbers your PC assigns to these may vary. (COM3) and (COM4) are shown in this example.

   *Note: StarFire has two (2) Serial ports connected to the single USB device inside.*

2. Close the Devices and Printer window
Windows XP Install

If your computer is running Windows XP, the Prolific Drivers may install automatically. A message will pop up indicating new hardware is ready for use. If any additional windows appear asking if you want to do anything with files found on the Controller, just close them at this time.

You can jump ahead to “Installing the StarFire Software” on page 22.

If you see the following window when you first connect your PC to the StarFire Controller with Windows XP, click “Cancel”

![Found New Hardware Wizard]

Note: Without the Prolific Drivers you will be unable to complete the Found New Hardware Wizard. Continue to installing the Prolific Driver for StarFire on Windows XP

Installing the Prolific Driver for StarFire on Windows XP

1. Open a Windows Explorer by right clicking your “Start” button on your PC and selecting “Explore.”

2. Click on “My Computer”
3. You should see the new STARFIRE USB disk under My Computer (in this example it is “USB DISK (F:)”
Double click the STARFIRE USB disk to open

4. Double click “PL2303_Prolific_DriverInstaller_v1210.exe” to install the Driver.

6. You will see “Preparing Setup” then the “InstallShield Wizard” will open.
Click “Next”
7. You will see the install Setup Status. The install may take a few minutes.  
   *Note: If the Setup Status window is automatically minimized or disappears, just wait for it to finish.*

8. On the Install Shield Wizard Complete window
   Click “Finish”
Verify the Prolific Driver was Successfully Installed on Windows XP

1. Navigate to and open the Device Manager window on your PC.  
   From the “Start” menu or the desktop icon  
   Right click on “My Computer”, select “Manage”

![Device Manager Window](image)

2. Click “Device Manager”  
   Notice that under Ports (COM & LPT), are two (2) Prolific USB-to-Serial Comm Ports now listed. The numbers your PC assigns to these may vary. (COM10) and (COM11) are shown in this example.

   *Note: StarFire has two (2) Serial ports connected to the single USB device inside.*

3. Close the Computer Management window
Installing the StarFire Software

Window 7 or Window XP

1. Go back to the STARFIRE USB disk

2. Right click the StarFireX.X.X(YYYY.MM.DDD).zip and select Extract All...
   An Extract Wizard will appear. By default is will have the extracted files placed in the same folder as the zipped folder.
   Click Extract and wait for the file extraction to complete.
   Note: StarFire software version numbers may vary. For the most up-to-date version of the StarFire software visit www.starfiresales.com/update

3. Double click to open the extracted folder StarFireX.X.X(YYYY.MM.DDD).zip

4. Double click “setup.exe”
   This will launch the StarFire Setup Wizard to install the StarFire software.
5. You should get the “Welcome to the StarFire Setup Wizard” - Click “Next.”

   Note: If you get a message indicating that Microsoft .NET 2 needs to be installed, click “Cancel.” You need to install the .NET 2 before you can install StarFire.

   a. Double click to open the folder “dotnet2_install files.”
   b. Double click “dotnetfx.exe.”
   c. You will see .NET Framework 2.0 License agreement. Click “Accept”
   d. This may take a few minutes. After .NET 2 is finished installing.
   e. Go back to the “setup.exe” and continue to install the StarFire software.

6. Continue each step of the Installation Wizard by clicking “Next.”
7. When it has Completed the Installation, click “Close.”

A StarFire shortcut icon will now be located on both your desktop and the programs section of your Start menu. Use either of these to launch the StarFire software.

*Note: For the most up-to-date version of the StarFire software or manual visit our “Update” page at [www.starfiresales.com/update](http://www.starfiresales.com/update).*
Testing Communication between the StarFire Software on your PC and the Controller

1. Using a USB cable, connect your PC/laptop to the StarFire controller.

2. Turn on the StarFire controller.

3. On your PC, Double click on the StarFire desktop icon.

4. At the top of the software window is the version number and the status of the connection with the controller. It should say “Connected.”
   If it says “Not Connected”
   a. Check your USB connections and make sure the controller is on.
   b. Select the Tools menu then Connect in the StarFire PC Software reattempt connecting to the StarFire controller.
How to Connect the Module(s) to the Controller and Scan for Modules

1. Connect the module to the StarFire controller.
   a. Using 22AWG or larger duplex wire (two conductor wire, such as Seminal Shoot Wire) separate the strands of wire enough to reach the two terminals located on the face of the module.
   b. Strip the insulation off the ends of the wire strands.
   c. Push in on the terminal to open.
   d. Insert the stripped strand of wire into the hole and release.
      The terminals are spring loaded to clamp onto the wire.
   e. Insert the other strand of wire into the second terminal on the module.
   f. Repeat with the other end of the wire and connect to the communication channel terminals on the StarFire controller.

   Note: The terminals on the modules and the communication channels are **NOT polarity sensitive**. This means you do not need to worry about positive or negative when connecting the two wires at either end of the setup.

   Power and data is passed through the duplex wires. For this reason, we recommend that you **always turn your controller “OFF” when connecting modules**. Great care should be taken to not allow the stripped ends of the wires to accidently touch, as this may short out the system.

   When connecting multiple modules together, the stripped strands of wire are twisted together before inserting into the terminals. **Modules are then daisy chained together with any module connecting to the controller’s communication channel terminals.**

2. Turn the controller “ON” use “Master Power Switch.”

3. When the controller is fully up and running (about 15 seconds from power on) a message saying “Modules not scanned. Begin scanning for modules?” will appear; to “Scan for Modules” press “Yes” (L1). The controller will scan to find connected modules.

   ![figure](image_url)
   
   **Figure 6: Modules not scanned.**
4. When all of the modules (in this case 001 - 010 are connected) have been found, press “Cancel Scan” (R1), otherwise the controller will continue to scan for all 254 available module addresses.

![Module Scan](image)

Figure 7: Scanning for Modules

5. Review the list of found module addresses. It should match the number of modules connected. If not, check all of the wire connections and press “Rescan All.”

Note: If not all modules are found upon scanning, check to see if the modules are displaying their module numbers with blinking LED's. If they are not, there is no power going to those modules and a short in the system is the most likely cause. Carefully check your wire runs and make sure that there are no shorted connections or exposed splices in the field.
How to Program the Module Address Numbers and Read the Module Address (from the controller)

To insure proper communications between the controller and all of the modules, it is critical that each module has its own unique address. Unless the address of each module is known, we recommend connecting the modules to the controller to verify their addresses or reprogram their addresses before setting up in the field.

Note: For ease of identification during show setup, label the modules with their programmed address numbers.

1. After modules are connected and scanned. See “How to Connect the Module(s) to the Controller and Scan for Modules” on page 2526.

2. Press “Assign Address” (R3) to access the “Assign Module Address” screen.

3. Select the module serial number you want to address by highlighting its row; press “Select” (L2).

Figure 8: Assign Module Addresses

Note: If more than one module is connected, press the “Prev Module” (L4) or “Next Module” (L5) to highlight the module that you would like to change. Holding either of these buttons down will allow you to scroll rapidly through the list.
4. Notice the yellow bar at the bottom of the screen, “Enter 3 digit(s): _____”
Use the module keypad to enter a new 3 digit address.

Note: You must enter all three digits - use 001 for “1”
After the 3rd digit is entered you will see the confirmation message “REASSIGNED”

5. The screen will confirm with “REASSIGNED.” To verify this, you can also read
the module address directly from the module by counting the blinks on the LED.
See the next section “Read the Module Address (directly from the module)”

Note: You can sort by either module address or module serial number (L3) on the
“Assign Module Address” screen. However if your modules are addressed in the same
sequence with the serial numbers, you will not see a difference in sorting order.

Read the Module Address (directly from module)

1. Power the module.

   Note: The modules get their power from the controller through the two wires
connected to the terminals. A 9v battery has enough power to read the address. Simply
press the battery against the terminals to apply power. The battery terminals can be
either way as the module is not polarity sensitive.

2. Count the number of blinks on each of the address LEDs.

3. The first LED (orange) represents the hundreds digit (X _) of the address.
The middle LED (yellow) represents the tens digit (_ X _) of the address.
The last LED (green) represents the ones digit (_ _ X) of the address.

   Example: If the orange LED blinks once, the yellow LED blinks twice, and the green LED blinks three
times, the module address is 123.

   Note: The LEDs will blink in sequence with a pause
after the last green blink then it will repeat.

Figure 9: Read the Module Address (directly from module)
Basic Show Setup

Whether shooting a manually fired or a scripted show, the basis show setup is the same. After the show has been successfully set up, the process of checking continuity and firing the show are different.

Checklist

StarFire List:
- StarFire Controller (charged)
- Keys (for arming the system)
- Dead Man/StepFire Grip
- StarFire Module(s)
- Rail(s)
- Centronics Cables
- Shoot Wire (22AWG or larger duplex wire)
- StarFire Charger

For Scripted Shows:
- Laptop or USB Thumb Drive
- USB Cable
- Audio Cable(s)
- Setup Report(s)
- Back up copy of script and music files

Field Setup

This section is a guide of how to lay out all the components needed out in the field for a basic show and how to connect everything together.

For this example of setting up a show we will use two modules with the StarFire controller. One module (addressed to number 1) will be used for small shells and another module (addressed to number 2) for large shells.

The process of setting up more modules (up to 254 modules) is basically the same as for setting up two modules with one difference. If a large number of modules are needed, additional communication channels are required on the StarFire controller. One communication channel can handle a maximum of 32 modules. The total number of modules per communication channel depends on wire lengths.

Note: Plan to test the firing system early, when there are hours to fix problems. The use of two way radios helps when troubleshooting continuity issues. Have one person at the controller and another person at the location of the module/rail being tested. If time allows, check each module as it gets done one at a time, so that during the final check, there are very few if any individual cue problems.
1. Before setup, make sure that the modules are programmed to **different address numbers** (1, 2... etc.). See the section “How to Program the Module Address Numbers and Read the Module Address (from the controller)” on page 28.

   **Note:** It is critical that each module has its own unique address number to insure proper communications between the controller and each module.

2. Set up the two racks of mortar tubes in the shoot zone, E-Match and drop your shells into the mortar tubes.

3. Position the rails next to the racks. Either attach the rails to the rack or position the rails on the ground.

4. Connect the firework’s E-Matches to the rails by first striping the two ends of the wire, then make a small loop on each of the wire ends, and insert into the terminals on the rail. Ensure that you have solid contact with the E-Match wire and not the insulation.

5. Use Centronics cables to connect each rail to its corresponding module. The cable’s length depends on how close the module is to the rail and the rack. 

   **Note:** We recommend that the rails are disconnected from the modules during the step “Checking Firing Voltage.”

6. Place the StarFire Controller in the location where you intend to fire the show.

7. Run 22AWG or larger duplex wire (two conductor wire, such as Seminal Shoot Wire) as data cable and connect module 1 to module 2. When connecting two or more modules, daisy chain the modules together with the shoot wire. Twist the ends of...
paired wires together in parallel. Insert wires into the module terminals. Numerous modules can be daisy chained together.

8. Finally run the spool of shoot wire from module 1 to the StarFire Controller to create a “Trunk Line.” Cut and strip the ends of the wire and insert the wires into the communication channel terminals on the StarFire Controller panel.

Check Module Input Voltage
This is to ensure that you have enough power going to each of the modules once they are all connected in the field.

1. Turn on the “Master Power” on the Controller.

2. Scan for Modules. For help with this see “How to Connect the Module(s) to the Controller and Scan for Modules” on page 26.

3. Review the list of found modules. Ensure all of the modules are found, and then continue to the next step.

   If modules are missing, check to make sure they are all connected correctly. Look for a faulty connection or a bad cable. If they still do not show up, try reassigning a module’s address. See “How to Program the Module Address Numbers and Read the Module Address (from the controller)” on page 28. Once all modules are found, press “Cancel Scan” (R1).

   SAFETY WARNING: The StarFire Controller should always be turned “OFF” whenever the duplex wires are being connected, removed or reconnected to the modules or the comms channel terminals. As with any electrical system, great care should be taken to avoid short-circuits (do not allow the wires to touch each other.) Accidental shorting out of the comms channel may occur if wires touch. If this occurs, the red LED for the comms channel (between the terminals) on the controller will blink. Again, great care should be taken to ensure that nothing conductive is placed on the controller near any of the terminals or any other input connections.

4. Press “Module Status” (R4) to access the “Module Status” screen

5. Input voltage of each module is displayed on the “Module Status” screen.
6. Check that all modules are listed and have input voltage of 20v or more. Then continue to the next step.

If input voltage is less than 20v on any of the modules, there are a few options. **Remember to turn off the controller while adjusting the wiring.**

a. Reduce the number of modules on each trunk line.  
   By running another trunk line, the number of modules that are daisy chained together in a given group is reduced. Multiple trunk lines can be powered off of a single Comm Channel.

b. Double up the trunk line.  
   In this case polarity of the duplex wires matters, but only for the trunk lines. 
   Run an identical trunk line from the controller to the first module being careful to ensure that the twisted ends of the wires match polarity.

7. Press “Main Menu” (L1) to return to the “Main Menu.”

*Note: The “Module Status” Screen can be accessed from the “Main Menu” screen at any time by pressing “Module Status” (R4) or from the “Module Scan” and “Continuity” Screens when performing those functions.*
Check Firing Voltage

To ensure enough input and firing voltage at each module(s), check them by following these steps. **It is helpful to time how long it takes to “Arm” the system and fully power up the modules.** The time will vary from show to show depending on how many modules are used and the amount of wire needed for the setup.

1. Press “Module Status” (R4).
2. Make sure the field is safe and the rails are disconnected from the modules.
3. Turn the “Key Switch” to the “Arm” position.
   a. The “Armed” red LED next to the “Key Switch” on the controller comes on.
   b. The “ARMED” message is blinking in the top right hand corner of the controller screen.
   c. On each module the “Armed LED” is a solid red and the “Comms LED” is blinking green.

![Figure 12: System Armed](image)

4. In “Module Status” - Press “Recheck All” (L3)

   *Note: It takes time for all modules to power up. Press “Recheck All” (L3) again after allowing for the firing voltage to build up. For larger show, this may take a minute or two depending on the setup.*

   For checking a single module, highlight its row and press “Recheck” (L2).
It is normal for the input voltage to decrease after the system is armed because the controller is sending power to the modules.

We recommend at least 20v of firing voltage for each module to ensure the show will fire properly.

5. Turn the Safe/Arm key to the “Safe” position until you are ready to fire your show.

6. Proceed to “Continuity Check” or turn the Mater Power “OFF” until ready to do a continuity check.

After this, the process you follow will depend on the firing method of the show.

For a “Manually Fired” show continue to “Manually Fired Show” on page 36.

For a “Scripted” show proceed to “Scripted Show - Continuity Check” on page 50.
Manually Fired Show

Continuity Check

1. Press “Continuity” (R5) and the “Module Continuity” window is displayed. The system will immediately begin to scan modules for continuity starting at module 001 and continue until all modules are processed. The results of the continuity check will be displayed.

   Across the top of the screen – the rail cues 01 to 32 are listed from left to right.
   Example: 0 = cue 01 and 2 = cue 25

   Each module is followed by the continuity values for its corresponding rail. Cue continuity values are displayed from left to right (underneath and corresponding to the rail cue numbers at the top of the window).

   Cues continuity values are represented by a code letter. The code key is also displayed in the green bar at the bottom of the screen.

   - “G” means it is good
   - “F” means fair or marginal, as in it may or may not fire
   - “P” means poor, as in something is connected, but it probably will not fire
   - “_” means open circuit, as in nothing connected or very high resistance

   A “No Response!” means the controller was not able to get a reply from a module that was found during initial module scan. See “Continuity Troubleshooting Help”
2. The row highlighted indicates which module is selected. Notice that in the Cue section (14 in Figure 2: Controller Layout on page 10) of the StarFire Controller, the green LEDs will be on above each cue button that has good continuity. Pressing “Next Module” (L5) or “Prev Module” (L4) allows you to scroll through the modules and changes the highlighted row/selected module. The Module Continuity window can only display a limited number of modules at a time. To view and select additional modules, continue to scroll (up/down) through the list.

3. In Figure 14: Module Continuity: Module 001 shows cues 15 and 32 as open (“_”) and Module 002 through 010 are good (“G”). At this point, Module 001’s rail should be inspected at cue positions 15 and 32 in the field, ensuring that the E-Match wires are inserted correctly and have contact. Press “Recheck” (R2) to recheck the highlighted rows continuity or “Recheck All” (R3). Repeat this troubleshooting for each module until all cue values show “G”
Continuity Troubleshooting Help

If a module is listed but has all “_” open codes for every cue: Inspect the Centronics cable connection between the module and the rail. Highlight the module and press “Recheck.”

If a module is listed but has missing cues (“_” open): Inspect the E-Match connections in the corresponding rail cues to ensure they have contact. Highlight the module and press “Recheck.”

If a module is listed but you got “No Response!”: The controller and module have lost communications after the initial scan.
   a. Highlight the module and press “Recheck”
   b. If you still get “No Response!” visually check the module in the field to ensure that it is powered on (the address LEDs will be blinking). If it is not, turn the controller “OFF” check the duplex wire connections to the module. Turn controller “ON.” Scan for modules and check continuity again.

If a module is NOT listed: Turn the controller “OFF” check the duplex wire connections to the module. Turn controller “ON.” Scan for modules and check continuity again.

SAFETY WARNING: The StarFire Controller should always be turned “OFF” whenever the duplex wires are being connected, removed or reconnected to the modules or the comms channel terminals. As with any electrical system, great care should be taken to avoid short-circuits (do not allow the wires to touch each other.) Accidental shorting out of the comms channel may occur if wires touch. If this occurs, the red LED for the comms channel (between the terminals) on the controller will blink. Again, great care should be taken to ensure that nothing conductive is placed on the controller near any of the terminals or any other input connections.
Firing a Manually Fired Show

1. From the “Main Menu” – Press “Manual Show” (L3)
   In the “Manual Show” screen, the found module’s addresses and serial #s are displayed.

![Manual Show Screen]

Figure 15: Manual Firing Mode

2. The Cue section on the StarFire Controller panel will show green LEDs for all cues connected and available to be fired corresponding to the module selected on screen.

   Note: If some of the “Cue LEDs” are not lit, before arming you may perform an optional continuity check of the selected module by pressing “Recheck Module” (R2). If a cue softkey is pressed while the StarFire Controller’s “Key Switch” is on “Safe” a message pops up that says “NOT ARMED!”

3. Make sure the field is safe. Turn the “Key Switch” to the “Arm” position.

   Note: “ARMED” is blinking in red on the top right side of the screen.
4. You may recheck firing voltage again, but it is not required. From “Main Menu” press “Module Status”, then “Recheck All”.

*Note: Remember it will take a moment for the modules to reach full firing power, you may need to press “Recheck All” again if the fire voltage seems too low.*

5. Select the module to fire by using one of the methods below.
   
   a. Use the “Next Module” (L5) or “Previous Module” (L4).
   
   b. Use the “Module” keypad to enter module number.

   *Note: “Digits XXX” (R5) represents the number of digits required to key in to change the module selection. You will see either “XXX” for 3 digits, “XX” for 2 digits or “X” for 1 digit. Pressing “Digits XXX” (R5) will cycle through these choices.*

   **Example:** To change to module address “002”
   
   “XXX” = “002”
   ̶ “XX” = “02”
   ̶ “X” = “2”

   By default the module with the lowest address is selected.

6. Press the number softkey in the “Cue” section of the controller, to fire the corresponding fireworks attached to the selected module’s rail.

![Cue Softkeys](image)

*Figure 16: Manual Firing "Cue" Softkeys*

Once fired the corresponding green LED above the cue softkey will go out.

*Note: In Manual Firing Mode you may switch between modules at any time and fire cues in any order.*
Using the StepFire Mode to Manually Fire

a. Attach Dead Man/StepFire grip cable to the controller.

![Figure 17: StepFire in Manual Firing Mode](image)

b. On the grip, squeeze the “Dead Man Trigger” and hold, then press the “Manual StepFire Button” to begin firing the show.

*Note: StepFire Mode will fire one cue at a time in numerical order based on the module address then cue number. It will automatically advance to the next module address listed.*

7. When the display is completed, turn the Arm Key Switch to “SAFE.”

Turn “OFF” the Main Power switch on the controller.
Preparation for a Scripted Show

Scripting the Show

A basic firing script can be created with the StarFire software or in Microsoft Excel. For advanced, shows we recommend using a commercially available scripting software. Be sure the software you choose is able to save your script with the StarFire (.star) file extension.

StarFire Software Basics

Figure 18: Software - "Connected" or "Not Connected" to the controller

Figure 19: Software - File, Tools and Help menus

Figure 20: Software - Find Updates

Located under the Help menu “About”, is the “Find Updates” button.

This will link you to the “Update” page of our web site.

http://starfiresales.com/update.shtml

Figure 21: Software - Window Tabs

Script, System Testing and Fire Control
Figure 22: Software - Script Tab

Script View window
- Open Script
- Save Script
- Create New Script
- Transfer to Controller

Figure 23: Software - System Testing Tab

System Test window
- Module Check

Figure 24: Software - Fire Control Tab

Shows Script Time
- Reset Time

Highlights what has fired
Sorting Table Data

Sort by ascending or descending order by clicking the column header to toggle sort order, note the solid arrow pointing up or down in the examples.

Hover over the header and click on the menu arrow box to sort by specific data contained in that column.

Right click on the header to see an additional sorting menu. Note: Use the “Column Chooser” for customizing the table view. This allows you to drag and drop columns into or out of the table.

Figure 25: Sorting Data in Software Tables
Required Components of a Basic Script

All that is required for a basic script is the module address with its corresponding cue position and firing time. Everything else is optional information that will help when setting up the show out in the field.

- **Mod** = Module Address, valid entry range of 1-254
  
  *Note: Do not enter preceding zeros for single or double digit addresses.
  *Example: For module address “001” enter “1” and “010” enter “10.”

- **Cue** = Cue position on the corresponding rail, valid entry range of 1-32.

- **Fire Time** = The time E-Match is ignited, this is entered in seconds with 1/100 of a second timing (0.01 second) accuracy.
  
  *Note: We recommend that the first cue’s fire time start at 10 seconds.

Additional Script Field Definitions

- **Display Time** = The time the effect is viewed (example: shell break)
- **Quantity** = The number of E-Match wired (in series or in parallel) for that cue.
- **Part Number** = The effects part number or ID number.
- **Description** = Describes the effect.
- **Type** = Type of effect (example: shell, comet or mine).
- **Size** = The diameter of the effect (example: 2”, 3”, 4”…).
- **Disable Type** = A keyword used to identify a group of items that you may want to disable during the firing of the show.

Creating a Basic Script with the StarFire Software

1. Open the StarFire software on a PC computer.

2. Click “Create a New Script”
   
   *Note: By “Creating a New Script” any script currently displayed will be cleared.

3. Click “OK.”

4. Enter the data for your script.
5. To “Edit” an item in the script
   Click the field you want to edit.
   *Note: The “Edit” icon appears at the end of the row.*

6. “Right Click” in front of a row to access the menu to
   Insert, Delete, Copy and Paste a row.

7. If you copied and pasted a row into your script, the
   software will require you to enter new data for the “copied
   item’s” Mod & Cue.

8. Click “Save Script.”

9. Name the script and click “Save.”

**Creating a Basic Script with Excel**

The data required for scripting a basic show can also be done with Microsoft Excel or
other spreadsheet software applications.

1. It is critical that the column order matches the exact order as this script sample.

   **Figure 26: Excel Template for a Basic Script**

2. **IMPORTANT!**
   Save As “Text (Tab delimited) (*.txt).”
3. Click “OK.”

4. Click “Yes.”

Now you can open your SF-Script.txt file with the StarFire software.

Opening a Script into the Software

1. On your PC, Open the StarFire software.
2. Click “Open Script”
3. Browse to your script file and click “Open.”
Time Code

Time code is generated data that identifies and logs time. The StarFire system uses time code to synchronize the controller, field modules, and soundtrack (if applicable) during a scripted display.

Internal Time Code

Internal time code is employed when shooting a scripted show without a music soundtrack. Internal time code is initiated from the StarFire controller.

Audio Time Code

The StarFire system uses a proprietary form of frequency-shift key (FSK) audio time code. Once added to the audio soundtrack the time code allows the StarFire system to precisely synchronize to any point in the audio soundtrack. The soundtrack can therefore be paused, rewound, forwarded, etc. and the StarFire system will immediately synchronize to that point.

The time code creation process merges the left and right channels of the audio file, places the merged audio on the left channel, and adds StarFire FSK time code to the right channel. When the music is played the controller receives the time code via the right channel thus synchronizing music and firing.

Audio File/Music Soundtrack File Requirements

- WAV file format
- Two channel stereo
- Sample rate of 44,100 Hz (44.1 kHz)
- Bit depth of 16-bit

Adding Time Code to your Audio File

1. Open the StarFire software on a PC computer
2. From the Tools menu, select “Create Time Code”  
   Note: Version 1 time code is not compatible with Version 2 systems. When prompted select the version of time code you would like to create.
3. Click “Select WAV File”, browse to your audio file, click “Open”
4. Click “Convert File”, enter a file name for the new file, click “Save”
5. The new WAV file with time code has now been created, Press “Done” to exit the Time Code Creator
6. Review (at minimum) a short portion of the beginning and end of the new WAV file to confirm the process was successfully completed.
7. Verify the duration of the file matches the original
   a. The left channel should contain the original music/audio
   b. The right channel should contain StarFire audio time code

Note: Use your computer’s audio balance control to isolate the left or right audio channel while listening to the soundtrack.
Creating/Repairing an Audio File

If you are unable to successfully complete the audio time code creation process it is likely that the original WAV file does not conform to the file requirements.

Follow these steps to create a compatible WAV file:

1. Download Audacity from http://audacity.sourceforge.net/download/
   *Audacity is a free, easy-to-use and multilingual audio editor and recorder for Windows, Mac OS X, GNU/Linux and other operating systems.*
2. Install and run Audacity
3. From the File menu click “Open…”
4. Select your original audio file and click “Open” – the audio file will be loaded into Audacity
5. From the File menu click “Export”
6. Choose a destination folder and file name for the new audio file
7. Set the “Save as type:” option to “WAV (Microsoft) signed 16 bit PCM” and click save

The resulting audio file meets the necessary requirements. Refer to the previous section “Adding Time Code to your Audio File”.

Testing Audio Time Code

**IMPORTANT: the audio equipment used must have STEREO output!**

1. Connect the right channel of the audio output to the Time Code Input on the StarFire controller (3-pin XLR or RCA)
2. Play the music soundtrack that contains time code
3. When time code is received it will be displayed on the StarFire controller at top center of the screen as shown below

![Time Code]

**NOTE:** Be sure to test your sound equipment to make sure you are getting audio on the left channel and time code on the right channel. Some PC sound cards will bleed time code into the audio channel resulting in time code drowning out your audio. If your PC mixes these channels, we recommend using an external USB sound card such as the Behringer UCA202 Audio Interface.
Scripted Show

Field Setup of a Scripted Show
Refer back to “Basic Show Setup” on page 30.

Continuity Check

1. With the PC running, connect the USB cable to the StarFire Controller.
2. Turn the Controller on with the “Master Power” switch
3. On your PC, Open the StarFire software.
4. Click “Open Script”
5. Browse to your script file and click “Open.”
6. In the software, check to see that the controller is “Connected.”
   If you see “Not Connected” (located in the top brown bar, after version number)
   • Check the USB cable connection
   • Make sure the controller is “ON”
   • Click the “Tools” menu, select “Connect”
7. Click the “System Testing” tab located at the top of the window.
8. Click the “Module Check” button.
The “System Test” window reports (Columns shown in default view)
- Mod = Module Address
- S/N = Serial Number of the module
- Chan = Comms Channel the module is connected to
- Input Volts = Input Voltage to the module
- Firing Volts = Firing Voltage to the module (this will remain zero (0) until the system/controller is “ARMED”)
- Open Cues = List of cues that have an “open” circuit, meaning they will not fire
- Marginal Cues = List of cues that are registering but have a poor connection and may not fire
- Invalid Cues = List of cues that are connected to the rail/module that have no scripted firing information.

An additional column may be added to the “System Test” table view (Right click column header and select Column Chooser, then drag and drop)
- Good = List of cues that are “good” and ready to fire

By clicking the “Stat” button at the beginning of each row, just that module’s status is rechecked. To recheck all of the modules click “Module Check.”

![System Test Table](image)

**Figure 28: Scripted Show - Continuity Check Through the Software**

The example shows that Module 1, Cue 21 has no continuity & 32 is marginal, both should be rechecked.

*Note: After the first “Module Check,” the table row height may not be fully expanded. You may want to maximize the software window. The column width may also be adjusted by hovering over the bar between the header cells until the double arrow appears, then drag left or right.*
Transferring Script to the Controller

There are two options for transferring a script into the controller:

1. Using a USB thumb drive
2. Using the StarFire PC software

Option 1: Using the PC Software to Transfer a Script

To transfer a script via the StarFire PC Software, the controller must be “ON” and connected to your PC. The StarFire software must be running with the script open.

1. On the controller, “Scan for Modules” and press “Main Menu” to enter the “Main Menu” screen.

2. In the PC software “Script” tab, open the script (refer back to “Figure 27: Opening a Script into the Software” page 47) and then click on “Transfer to Controller”

   Note: On the controller, the message at the bottom of the screen will indicate that it is “Downloading script from PC.”

Option 2: Using a USB Flash Drive to Load a Script

1. Save a copy of your firing script (.star file) to a USB Flash Drive

2. Insert the USB Flash drive into the controller. A brief message should appear that reads “Scanning…Do not remove storage device”

3. From the main menu, select “Scripted Show” (L5)

4. Select “Load Script” (L2)

5. At this point, all of the “.star” files that are on the USB Flash Drive will be listed. Use the “Next Script” (L5) and “Previous Script” (L4) buttons to highlight the script you want to shoot.
6. Press “Select Script” (L3) when you have the correct script highlighted. The controller will read the script and the loaded script message will flash on the bottom of the screen.

7. Press “Back” (L1) to return to scripted show mode.

8. Follow the steps for “Sending the Script to the Modules”

**Restoring a Script**

The last script that was loaded or transferred into the controller can be restored at any time without a PC or USB flash drive. The StarFire controller will store one script at a time until it is overwritten with a new script. To access this previously loaded script, you can use the restore feature.

1. From the main menu, go to “Scripted Show” (L5)

2. Select “Restore Script” (L3)

3. The last script that was loaded or transferred into the controller will be restored. *Note: The loaded script message will flash again at the bottom of the screen.*

4. Follow the steps for “Sending the Script to the Modules”
Sending the Script to the Modules

Once a script has been loaded into the controller, the modules must be programmed with the script.

1. In the “Scripted Show” screen, select “Program Modules” (L4)

The controller will show which module is being programmed at the bottom of the screen. As modules are programmed, they will reply to the controller with the status of whether or not the programming was complete. Notice on the face of the module, the “Comms LED” will blink green when it is receiving a message and it will blink red when it is replying.

![Scripted Show screen](image)

Figure 30: Sending the Script to the Modules

Once the controller is done programming all of the modules with the script, a summary page will appear. The summary will outline what script was loaded, as well as what modules had errors if any. If the script has loaded correctly, the following message should appear:

```
Programmed modules at address: 002
```

Loaded script name: script.star

```
Summary

4 Module(s) of 4 programmed correctly.
```
If there were problems encountered during the programming of modules, the summary screen will list the modules that it was not able to program.

```
----------------------- Programming -----------------------
Loaded script name: script.star

----------------------- Summary -----------------------
3 Module(s) of 4 programmed correctly.
Module address(es) failed: 004
```

```
----------------------- Programming -----------------------
Loaded script name: script.star
Module 004 not scanned. Skipping.

----------------------- Summary -----------------------
3 Module(s) of 4 programmed correctly.
Module address(es) skipped: 004
```

Note: Make note of any modules that are having troubles receiving the script. Once the controller has completed the process of sending the script to the modules, troubleshoot any module that had communication problems by first checking that it is receiving power.

**IMPORTANT:** Any time you are disconnecting or reconnecting the duplex wires the controller should be turned “OFF.”

Your script is now transferred to the StarFire controller and modules.

**IMPORTANT:** The script is only kept in short term memory on the modules. Once the controller is turned “OFF”, the modules lose power and the module’s short term memory is cleared. The modules DO NOT save any scripts. Each time the system is powered “ON” the script must be sent to the modules before they can fire.
Firing a Scripted Show

At this point you should have already completed the following:
1. Show Setup
2. Checked Input Voltage
3. Checked Firing Voltage
4. Timed how long it takes to fully power the system based on this show’s set up.
5. Checked Continuity
6. Tested the Time Code Communications between the Audio Feed and the Controller (if scripted to music)
7. Transferred/loaded a script (from the PC software or a USB drive) to the Controller
8. Programed the Modules

**IMPORTANT NOTE:** Each time you reboot the controller (turn it “OFF then ON” again) you MUST SCAN for Modules, TRANSFER, LOAD or RESTORE the Script and PROGRAM Modules before it will fire.

1. With the software opened, select the “Fire Control” tab.

2. On the controller, you should be in the “Scripted Show” screen, with the script already sent to the modules.

3. Attach the Dead Man cable to the StarFire Controller.
   *Note: The Dead Man switch is recommended but optional; the system will fire without it connected. Once connected, the system will require that you squeeze and hold the trigger of the “Dead Man Switch” for the duration of the show. The switch functions by allowing time code messages to be sent to the modules. Any time you release the trigger time code is stopped, thus pausing the show until time code continues.*

4. Squeeze the trigger to activate the Dead Man switch.
   Continue squeezing the trigger during the show.

5. Make sure that the field is safe, turn the “Key Switch” to the “Arm” position.

6. Wait for the system to power up the modules to full firing voltage.
   *Note: The length of time needed was determined earlier during “Checking Firing Voltage.”*

7. Press “Start Show” (R3).
8. Start the “Time Code” by one of the following methods.
   b. Start audio feed with embedded Time Code
      Note: you do not need to press the Start Show button. The show will fire if the system is armed and the time code is being sent to the modules.

9. Things to monitor during the show.
   a. On the controller screen, the Time Code clock counting upward
   b. The cues being to fire as scripted (fireworks going off)
   c. In the software, under the “Fire Control” tab:
      • The “Script Time” clock counting upward
         Note: The Script Time and the Time Code will both count upward once the show starts. However, each clock has to be reset independently.
      • The script will begin to scroll and the rows will be highlighted red as the time code reaches each line’s “Fire Time.”

10. When the script is done. The controller will show message “SHOW COMPLETE!!”

11. Turn “Key Switch” to “Safe” position.

12. Press “Main Menu” (L1).

**In case of an EMERGENCY – How to “STOP THE SHOW”**
Use one or more of the ways listed below to stop the show in case of an emergency.

1. Release the trigger on the dead man switch.


3. Stop the Time Code
   b. Stop audio playback on external audio time code
   c. Unplug audio/time code cable

4. Turn the arm key switch to the “Safe” position

5. Turn “Master Power” switch “OFF” (NOT Recommended)
Restarting the Show
Depending on how and why the show was stopped, see the list below how to restart it.

If Dead Man grip trigger was released
   Squeeze the trigger on the Dead Man grip

If “Emergency Shut-Off” switch was pushed down
   Pull the “Emergency Shut-Off” switch up
   Cycle the arm key switch to rearm the system

If Time Code was stopped by:

      Note: This will pick up the time code at the same time it was paused. If you press
      “Reset Manual Time code” it will start from the beginning (00.00).

Stopping external audio feed with the embedded time code
   Play external audio

      Note: The system will pick up wherever the embedded time code in the audio file
      is. So if a song was skipped the firing script will skip it too.

Unplugging audio/time code cable
   Adjust audio playback to the correct time
   Reconnect the Audio cable
   Play external audio

      Note: The system will pick up wherever the embedded Time Code in the audio file
      is. So if a song was skipped the firing script will skip it too.

If the “Key Switch” was turned to the “Safe” position
   Turn the key switch to the “Arm” position
   Start manual or external audio time code as needed

If the “Master Power” switch was turned “OFF”
   At present the field modules store the firing script only while powered. Therefore,
   if power is interrupted to the field modules during a display they must be re-
   programmed before resuming the display. Once the modules have been
   reprogrammed arm the system and resume audio or manual time code as needed.
SequenceFire Show

SequenceFire is a hybrid firing mode between a manual show and a fully automatic script display. SequenceFire allows the user to design and shoot groups of cues or “sequences” in a fireworks display. Sequences are segments of a script that can be initiated individually by the user. A sequence may be a single cue or multiple cues across one or more modules.

Scripting a SequenceFire Show

A basic SequenceFire script can be created with the StarFire software or in Microsoft Excel. For advanced, shows we recommend using a commercially available scripting software. Verify your software is compatible with the StarFire system.

Required Components for SequenceFire Script

SequenceFire scripts are identical to those for a fully scripted display with the addition of three columns:

- **Sequence Event Name** = the title of a particular sequence. The Sequence Event Name is intended to make it easy for the user to identify what the particular sequence will do. This can be anything the user chooses, such as “Touchdown Sequence” or “Post Game Show”

- **Sequence Event Page** = this will identify what page the sequence will appear in the available list of sequences on the StarFire controller. Each page can have up to 32 sequences displayed.

- **Sequence Event Number** = the order in which the sequences will be displayed on the StarFire Controller.

*Note: The StarFire system assigns these fields based on their position in the “.Star” file. The column position, rather than its name, will take priority when the script is loaded into the controller. Be sure to use the proper formatting and column spacing when creating “.star” files.*
In the sample script, you can see that the first 10 cues all have the same Sequence Event Name and Number. This means that all of those cues will belong to one event, meaning that one button push will fire each of those cues. The next 10 cues have a different Sequence Name and Number. This means that they are all part of another sequence that will fire with one button push.

**Loading a Sequence Script**

1. Save your “.Star” file sequence script to a USB Flash Drive  
2. Insert the USB Flash Drive into the StarFire Controller  
3. Follow the proper steps for turning on the controller and scanning for modules  
4. From the “Main Menu” screen, press “Sequenced Show” (L4)  
5. From the “Sequenced Show” screen, press “Load Script” (L2)  
6. A list of available “.Star” files will appear. Use the “Previous Script” (L4) and “Next Script” (L5) buttons to highlight the proper script.
7. Once the correct script is highlighted, press “Select Script” (L3). The controller will load the script and display the title on the bottom.

8. Press “Back” (L1)
9. From the "Sequenced Show" screen, press "Program Modules" (R1). This will load the "*.star" file into the field modules.

Note: The blue status bar at the bottom of the screen displays which module is currently being programmed.
Firing a Sequenced Show

At this point you should have already completed the following:
1. Show Setup
2. Checked input voltage
3. Checked firing voltage
4. Timed how long it takes to fully power the system based on this show’s set up.
5. Checked continuity
6. Loaded the Sequenced Script(s) on the controller
7. Programed the Modules

**IMPORTANT NOTE:** Each time you reboot the controller (turn it “OFF then ON” again) you MUST SCAN for Modules, TRANSFER, LOAD or RESTORE the Script and PROGRAM Modules before it will fire.

1. On the controller, in the “Sequenced Show” screen, press “Start Show” (R5)

2. Make sure that the field is safe, turn the “Key Switch” to the “Arm” position.

3. Wait for the system to power up the modules to full firing voltage.
   *Note: The length of time needed was determined earlier during “Checking Firing Voltage.”*
4. A list of available sequences will appear.

5. Choose your sequence firing method.

   **Option 1:** Use the “Previous Event” (L4) and “Next Event” (L5) buttons to highlight the sequence you would like to fire. Then press “Fire Sequence” (R4).

   **Option 2:** Use the “Cue” number pad on the StarFire controller to fire the sequences. Press the “Cue” number that corresponds to the “Event” number to fire that event.

   **Option 3:** Use the “StepFire” button on the dead man switch to fire the sequence. Each button push will fire the next sequence in the list.

   *Note: There are 27 sequences listed per page on the StarFire controller. To list the next 27 sequences, use the “Previous Page” (R4) and “Next Page” (R5) buttons.*

6. Once you have completed your sequenced show, turn “Key Switch” to “Safe” position.
StarFire Controller Tools Menu

**Diagnose**

The “Diagnose” tool is intended to act as a look into how the controller’s computer is interpreting commands. The “Diagnose Screen” displays any commands that the controller’s computer is processing, whether they are sent by the software or by user input through the membrane buttons or switches.

This example shows the buttons tested and the “Battery Voltage” message that is sent every 30 seconds.

*Note: Button L1 “Tools Menu” cannot be tested in this screen because it is used to navigate back to the “Tools Menu”*

**System Version**

The “System Version Information” screen lists the release dates and version numbers for key components of your StarFire system, including the StarFire Controller Software Version, the PC104 Firmware Version and the Firmware version for each individual communications channel.
Run LED Test

The “Run LED Test” screen systematically checks each LED on the StarFire controller. This test is initiated by pressing “Run LED Test” (L5) in the “Tools Menu”. Once the test is initiated, every time (L5) is pressed the test will cycle through and systematically illuminate each LED in the panel. As each LED illuminates, the status of the name of that LED will appear on the screen. To complete the test, continue pressing L5 until the “LED Test Complete” message appears.

Continuous Scanning

The “Continuous Scanning” tool allows the user to test communications between the controller and the modules. When the “Continuous Scanning” button (R1) is pressed, a communication test between the controller and the modules is initiated. The “Module Polling Screen” will systematically test the communication path to each module that is connected one at a time and report the results.

When you “Cancel Polling” (R1) it reports the final results of the modules that were tested.
Updating the StarFire Controller

From time to time, updates may become available for the StarFire system. These updates can be installed remotely without the need to return the system.

There are 4 types of updates:
1. GUI (Graphic User Interface) Software
2. I/O Card Firmware
3. Communications Board Firmware
4. Field Module Firmware

Preparing for Updates

1. Go to www.starfiresales.com/update.shtml and download the latest files.
2. Copy the update files to the root directory of a USB Flash Drive.

Note: The GUI update has 2 files that must be updated together. Both of these files will be contained in a StarfireGUIversionX.X.X.X.zip file. Extract files by right clicking and selecting extract all. Copy the SF.exe and the Starfire.SerialDriver.dll to the root directory of the flash drive.
Updating the StarFire Controller GUI

1. Place the Flash Drive with update files into the USB Connector on the Controller and turn the Master Power Switch “ON”.

2. Note the Software Version on the top of the screen located to the right of the Firing Clock. When the updating process is completed, the new version number should reflect the newest uploaded version.

3. When prompted to scan for modules, press “No” (L2).

4. In the “Main Menu”, press “Tools Menu” (R1).

   
   *Note: This button will only appear in the “Tools” screen when a UBS Flash Drive containing a GUI update file is connected to the Controller when it is powered on.*

6. Turn the master power “OFF” for 5 seconds. Then turn it back “ON”.

7. Upon launching, a message will appear that reads “Found New Program” and a countdown. Wait for the countdown to complete and the initial “Module Scan” Screen to appear.

8. When prompted to scan for modules, select “No” (L2).


10. In the “Tools” screen, press “Update Firmware”. A message will appear that says “Do not attempt to install new software until you cycle system power.”

11. Turn the master power “OFF” for 5 seconds. Then turn it back “ON”.

12. The top of the screen should now display the new version number.

   *You have successfully updated your controller GUI!*
Updating the I/O Card Firmware

1. Place the Flash Drive with update files into the USB Connector on the Controller and turn “ON” the “Master Power Switch” on the Controller.

2. When prompted to scan for modules, press “No” (L2)

3. In the main menu, press “Tools Menu” (R1)


   Note: This button will only appear in the “Tools” screen when a UBS Flash Drive containing an update file is connected to the Controller when it is powered on.

5. In the “Reflash System Components” screen, highlight the most recent PC104 Board .ref file using the “Previous Firmware” (L4) and “Next Firmware” (L5) Buttons.

6. Once the correct PC104 Board .ref file is highlighted, press “Select Firmware” (L3).

7. Press “Reflash PC104” (L2). As the Firmware is updating, a status bar will appear that says “Downloading Record” along with a number. Once the download is complete, the update is finished. You have successfully updated your controller PC104!

   Note: When updating the PC104 Firmware, it is not necessary to restart the controller when the process is complete. If the updating process is interrupted while the PC104 Firmware is being re-flashed, the buttons on the controller will no longer function. In that case, a USB keyboard can be used in lieu of the panel buttons. Numbers 1-5 on the keyboard coincide with buttons L1-L5 on the controller. Numbers 6-0 on the keyboard coincide with buttons R1-R5 on the controller. By using a USB hub, the PC104 can be updated using a USB keyboard and the flash drive containing the firmware files.
## Updating the Communications Board Firmware

1. Place the Flash Drive with update files into the USB Connector on the Controller and turn “ON” the “Master Power Switch” on the Controller.

2. When prompted to scan for modules, press “No” (L2).

3. In the main menu, press “Tools Menu”.

   
   *Note: This button will only appear in the “Tools” screen when a UBS Flash Drive containing an update file is connected to the Controller when it is powered on.*

5. In the “Reflash System Components” screen, highlight the most recent Comms Board .ref file using “Previous Firmware” (L4) and “Next Firmware” (L5).

6. Once the correct Comms Board .ref file is highlighted, press “Select Firmware” (L3). A new set of buttons will appear that say “Reflash Com 1” through “Reflash Com 8”.

7. Press the coinciding “Reflash Com X” button for each communications channel that is physically installed on the controller. This will allow you to update each channel individually. As the Firmware is updating for each channel, a status bar will appear that says “Downloading Record” along with a number. Once the download is complete, the update is finished. This step must be repeated for each installed communications channel.

   ![Reflash System Components](image)

   *Note: When updating the communications channel firmware, it is not necessary to restart the controller when the process is complete. If a button is selected that coincides with a communications channel that is not currently installed in your controller, the update will time out in approximately 10 seconds.*
Updating the Field Module Firmware

1. Place the Flash Drive with update files into the USB Connector on the Controller.

2. Connect any modules that you would like to update to your controller as shown on page ( )

3. Turn “ON” the “Master Power Switch” on the Controller.

4. When prompted to scan for modules, press “Yes” (L1)

5. In the “Main Menu” press “Tools Menu” (R1)

   Note: This button will only appear in the “Tools” screen when a UBS Flash Drive containing an update file is connected to the Controller when it is powered on.

7. In the “Reflash System Components” screen, highlight the most recent Field Module .ref file using “Previous Firmware” (L4) and “Next Firmware” (L5)

8. Once the correct Field Module .ref file is highlighted, press “Select Firmware” (L3)
9. At this point, you can choose to update one field module at a time or all field modules

**Update one module at a time:**

a. Press “Reflash Module” (L2)

b. A bar will appear at the bottom of the screen that will allow you to enter the three digit module address of the module you would like to update. Use the “Module Selector Keypad” to enter the address.

c. Once the address is entered, the firmware update will initiate for that module. Notice status information displayed at the bottom of the controller screen and on the Module, the Armed LED will be blinking red as well as the Comms LED blinking red and green as data is sent back and forth.

d. Each module will take approximately 4 ½ minutes to update. When the module is updated, it should automatically restart.

**Updating all modules at once:**

a. Select “Reflash All” (L3)

b. Each module will update individually starting with the lowest numbered module and going up sequentially.

c. Each module will take approximately 4½ minutes to update. When each module is updated, it will automatically restart.
Note: If the updating process is interrupted for any module, that module will rapidly blink the red Arm LED when powered. This means that the firmware is corrupt on the module. This can be fixed using the “Reflash Repair” (L4) feature in the “Reflash System Components” screen. “Reflash Repair” can only be done with one module connected to the controller at a time.

Test Mode in StarFire Software on PC

The test mode is located under the “Tools” menu in the StarFire software.

The test mode is a system test that can be performed to check the communications between the controller and the modules.

The “System Test” test data is shown in addition to the following columns that are only used during the “Test Mode”:

- % Bad =
- Bad Resp =
- Good Resp =

Note if you right click on the column header and select “Column Chooser” you will see “Ignore” and “Mod Programmed” that are not currently used, but listed for future development:

- Ignore = Future Feature to allow you to not fire a selected module.
- Mod Programmed = Future Feature to indicate if module has received its script or not
Description of Controller Components and Connections

1. **Communication Channel Terminals**
   The StarFire Controller is capable of utilizing up to eight independent channels. These communication channel terminals connect to the modules with a duplex wire. Each communication channel is going to be able to control approximately thirty to forty modules depending on your wire length and distances and wire size.

2. **Power Plug**
   For future release once the internal battery charger is complete.

3. **Light Connection**
   The Light Connection provides power for an LED to illuminate the controller panel. The light itself contains red, white and a UV element. The UV portion will make the panel glow as the membrane panel contains a phosphorescent ink.

4. **Time Code Inputs**
   StarFire supports both XLR and RCA inputs for time code. The right audio channel of your audio playback equipment should be connected to either of these connections. The connections are internally joined, so you could feed one connection and then use the other connection to feed a second StarFire Controller if you were using two controllers for the same display.

5. **Network Connection**
   For future release, currently this port is used for the external battery charging connector.

6. **Computer USB-B Input**
   The USB connection will allow you to connect to a PC computer and use computer based software to program a script into the StarFire Controller, to do advance system testing, or to monitor the script during the firing of the display.

7. **USB-A for Flash Drive**
   This USB connector is so you can ultimately put your script on a memory stick and you plug into the StarFire Controller and from the on screen menu items you will be able to load a script out of like a USB memory drive or flash drive.

8. **Display Softkeys**
   These softkeys are used to interact with menu options displayed on the monitor.

9. **Color Display Monitor with Interactive Menu**
   StarFire uses an 800x600 resolution LCD color display which incorporates interactive menus through the use of soft keys. This full featured display will give you a lot of information right from the controller, without the need of connecting a PC to the system. Because the menus are software driven, we will
be able to continue to enhance the system hardware simply by providing free software updates.

10. **Master Power Switch**
   The master power switch turns the entire StarFire system on and off. At any time that the master power switch is on, the field modules that are connected to the controller are also powered.

11. **Safe/Arm Key Switch & LED**
   This switch is used to arm the firing circuitry only when it is time to shoot the display and the field is safe. The red LED will be lit to show the StarFire is “Armed.” If the switch is in the safe position, the firing circuit is not charged and firing commands cannot be sent. Only diagnostics commands are sent to the field modules such as continuity checks and module status.

12. **Dead Man/StepFire Grip Connector**
   The Dead Man Switch is required to shoot displays other than manual fire displays. The Dead Man Switch must be connected, and the trigger must be held during the entire display. If the switch is released, the system will stop firing until the switch is pressed again, at which point, it will start firing again. If needed, you can extend the cable on the Dead Man Switch using a standard 3 pin XLR male to female cable.

   The StepFire button on the grip may be used during a manually fired show as an alternate method of firing the cues.

13. **Emergency Shut Off Switch**
   If the Emergency Shut Off Switch is pressed down, it will stop the firing of the display, disarm the modules and block nearly all StarFire Controller system functionality.

14. **Cue Firing Softkeys & LEDs**
   The system was designed to both be a fully automated computer-fired system but also a manual firing system. Like most manual firing systems, the cue softkeys are used to fire the individual cues of the selected module. Up to 254 modules could be used in a manual show. The LEDs are lit to show continuity and after a cue is fired the LED will turn off.

15. **Module Selector Keypad**
   The module keypad is used to program the module addresses. Also, during a manually fired show it is used to select a module by typing in the address number.
Cleaning and Caring For Your StarFire

Protecting the Equipment

Firework fallout, combined with the typical evening dew in humid climates creates a very corrosive environment. Even with gold plated contacts, this corrosive mix will discolor and eventually corrode the electrical connections on both the modules and rails. Covering the equipment will help keep firework fallout off of the equipment and makes cleanup easier.

Treat the StarFire equipment as you would a laptop computer. Although it has been built to be durable, a controller or module might be damaged if it was dropped, hit with something or crushed under other equipment.

Controller and Screen

After each display ensure that the StarFire controller is completely dry inside. If there is any chance of moisture being inside the controller, from dew or rain, it is a good idea to open the case and allow it to dry out before storing. The controller must be completely dry before using or charging.

The screen of the controller can be scratched from dirt. Only use a damp cotton cloth to clean the screen and use the lightest touch possible to remove the dirt.

Module(s)

The modules are sealed to be as weather resistant as possible. After each display use a damp cloth to remove all of the fallout or dirt. Be sure that the centronics connectors and terminals are completely dry.

Rail(s)

After each display clean with a damp cloth to remove all of the fallout or dirt. A paint brush or compressed air also works well. Be sure that the centronics connectors and terminals are completely dry.

Cables & Duplex Data Wire

The centronics cables should be cleaned and dried after each use.

We recommend that you use new duplex wire on every display. Protect your data run from fire or damage. It is best to cover the wire closest to your fireworks to prevent the insulation on the wire from burning and shorting out the copper wires inside. Sand, plywood and to a lesser extent, aluminum foil will all help to protect the wire from getting burned. Also, the use of longer cables to connect your rails to your modules will allow your modules and the data wire to be further from the dangers of a burning lift cup, sparks or other hot debris that could burn the wire.

Duplex wire, particularly if it is a high quality wire, is reasonably resistant to vehicles driving over it a few times. If in a high traffic area, then the wire should be protected by cable trays, burying or by some other means so that it is not damaged.
## Module Wiring Limitation Chart

<table>
<thead>
<tr>
<th>Feet of 22 gauge wire</th>
<th># of field modules</th>
<th>Input voltage not Armed</th>
<th>Input voltage Armed</th>
<th>Firing voltage</th>
<th>Time to charge to Minimum of 16 v</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000 ft</td>
<td>8</td>
<td>16v</td>
<td>16v</td>
<td></td>
<td>5 min</td>
</tr>
<tr>
<td>1000 ft</td>
<td>7</td>
<td>18v</td>
<td>18v</td>
<td></td>
<td>3 min</td>
</tr>
<tr>
<td>1000 ft</td>
<td>6</td>
<td>20v</td>
<td>20v</td>
<td></td>
<td>2 min</td>
</tr>
<tr>
<td>1000 ft</td>
<td>5</td>
<td>23 v</td>
<td>23 v</td>
<td>24 v</td>
<td>18 sec</td>
</tr>
<tr>
<td>1000 ft</td>
<td>4</td>
<td>26 v</td>
<td>25 v</td>
<td>24 v</td>
<td>18 sec</td>
</tr>
<tr>
<td>1000 ft</td>
<td>40</td>
<td>22 v</td>
<td>20 v</td>
<td>20 v</td>
<td>60 sec</td>
</tr>
<tr>
<td>1 ft</td>
<td>40</td>
<td>31 v</td>
<td>Comm channel overload</td>
<td></td>
<td></td>
</tr>
<tr>
<td>30 ft</td>
<td>40</td>
<td>28 v</td>
<td>Comm channel overload</td>
<td></td>
<td></td>
</tr>
<tr>
<td>40 ft</td>
<td>40</td>
<td>27 v</td>
<td>25 v</td>
<td>24 v</td>
<td>20 sec</td>
</tr>
</tbody>
</table>

All Modules are connected by 1 foot 22 gauge shoot wire between each module.